
Welcome to URL Organizer 2!
Thank you for taking the time to evaluate URL Organizer 2. I hope you will soon discover 
just how sophisticated, powerful and innovative a tool it is for storing and organizing all your
URLs; and that you will quickly appreciate its finely-crafted and feature-rich interface.

You may want to check out the key features you can look forward to using, or you may want
to get started immediately. If, after consulting these help notes, you have any questions or 
suggestions about this program, please e-mail me and I will be happy to reply.

• ZD Net awarded four stars to version 2.0 (since when the program has improved almost 
beyond recognition).

• Tucows awarded four cows to version 2.2.
• PC World’s FileWorld chose version 2.2 as an Editor’s Pick.
• Skylark Utilities chose version 2.2 as an Editor’s Pick.



Getting Started
URL Organizer 2 is shareware, so you may install it and try it out for 30 days before paying 
a cent. Please consult the terms of the license to see the conditions under which you may 
use the program.

1. Install URL Organizer
If you have installed software before, you should have no difficulties with URL Organizer. 
Double-click on ‘setup.exe’ to start the process. See the notes on installation options.

2. Experiment with the basic features
When you first run URL Organizer, you will see loaded a sample URL list. First, check out the
different interface modes by selecting from the Application menu. Switch to Organize mode 
and experiment with the organizing facilities: see how to edit a URL or heading, re-order or 
re-group URLs and headings and add a note to a URL. Then see the different ways to add a 
new URL to the list.

3. Import your existing URLs
Now you probably want to see how URL Organizer looks with your own URLs loaded. See 
Importing URL Collections.

4. Get to know URL Organizer intimately
URL Organizer’s interface is probably quite unlike any other you’ve encountered. Don’t let 
this put you off: it’s very simple to use, and when you get the hang of it, very fast. Most of 
the functionality of URL Organizer you’ll discover by experimenting or by reading the rest of 
the Help notes. See in particular Keyboard Shortcuts and Tips.

5. Register URL Organizer
Hopefully you will be so impressed by URL Organizer you won’t have any doubts about 
registering. However you have 30 days to decide and e-mail support is always available to 
answer your queries.



Key Features of URL Organizer 2
URL Organizer 2 is a highly sophisticated tool for storing and organizing your URLs. These 
are just some of its key features:
General features
• URLs stored in a 3-level hierarchy so no URL is more than 3 mouse clicks away
• fast full-text search facility*
• instantly switch between up to 10 URL collections of up to 10,000 URLs each*
• instantly switch between up to 10 web browsers*
• loads in a snap and uses minimal disk space, memory and resources
• includes comprehensive integrated help notes**
Information stored
• web, e-mail and news addresses
• application, folder and document shortcuts**
• unlimited space for notes on each URL **
• site log-in names**
• time of last opening a URL*
Sophisticated organizing tools
• import and export URLs to/from Internet Explorer, Netscape Navigator and Opera**
• import Start Menu shortcuts**
• quick and easy to edit, re-order and re-group titles and URLs*
• support for aliases (multiple instances) of URLs**
• support for separators/dividers**
• drag and drop support**
• automatic and manual backup of URL collections**
• copy URLs as text or HTML**
Highly-configurable interface
• alternative interfaces: ‘Regular’, ‘Organize’ and ‘Compact’**
• fully-resizable windows**
• user-definable color scheme*

*Features more primitive(*) or not available(**) in freeware version



License
URL Organizer 2 is copyright (1998-1999) of Edward Leigh. It is distributed and sold as 
‘shareware’. It is NOT public domain or ‘freeware’.

In the license conditions that follow, three terms have special meaning:
• ‘ the Author’ shall refer to Edward Leigh, the author of URL Organizer 2
• ‘ the Program’ shall refer to URL Organizer 2
• ‘ the Licensee’ shall refer either to you as an individual plus any family with whom you 

share a computer or, if you will be using the Program in the capacity of an employee, to 
the company which employs you.

The Author grants the Licensee:
• the right to install and use the Program on any computer;
• the right to use the Program for thirty (30) consecutive days from the day of installation 

before the Licensee must either purchase a license or uninstall the Program

providing that the Licensee agrees to be bound by the following conditions:
• If the Licensee is a company, the number of licenses required at any one time equals the 

number of employees who use the Program. The number of licenses required specifically 
does not equal the maximum number of concurrent users of the Program, nor does it 
equal the number of computers on which the program is installed.

• The Program is licensed, not sold, to the Licensee.
• The Program is provided ‘as is’. The Licensee uses the Program entirely at its own risk. No 

warranties nor guarantees are included with the license. In no event shall the Author be 
liable for any consequential damages whatsoever (including, but not limited to, damages 
for loss of business profits or loss of business information) arising out of the use of, or the 
inability to use, the Program. In any case, the Author’s liability shall be limited to the price
paid for this license, or ten UK pounds sterling, whichever is the greater.

• The Licensee agrees to respect the copyright laws and international copyright treaties, as 
well as any other intellectual property laws and treaties that apply to the Program.

• The Licensee may not reverse engineer, decompile, disassemble or modify in any way 
whatsoever the Program.

• The Licensee may not sell, rent or lease the Program to anyone else. The Licensee may 
distribute only the most recent installation package as available from the Author’s Web 
site.

• This licence agreement is governed by the laws of England and Wales.

If The Licensee does not agree with the stated license conditions, please do not install URL 
Organizer; or if installed already, please uninstall URL Organizer 2 immediately.

See also:
• Registering and Purchasing a License



Registering and Purchasing a license
URL Organizer 2 is SIVL-compliant shareware. This means that, in order to fully-enable the 
program’s functionality, you must register it with OSoLiS. Functionality is limited after the 
30 day evaluation period is over, but you will always have access to your URLs and, should 
you decide that URL Organizer is not for you, you can export your URLs back to Internet 
Explorer, Netscape Navigator or Opera.

As of the release of version 2.3, a license to use URL Organizer (see the terms of the 
license) costs US$20. Up-to-date pricing, including special offers and discounts, is available 
on the registration site: http://www.osolis.com/cgi-bin/register.cgi?2

OSoLiS currently accepts payment by VISA, MasterCard, American Express and NOVUS 
Discover charge cards. Payments by check are not accepted at this time, but please contact 
me if you are unable to pay by any other means.

Registration steps
To access the OSoLiS registration service, either:
• Go to About URL Organizer under the Application menu, and click the Register button 

whilst you are connected to the Internet,
or

• Go on the Internet to http://www.osolis.com/en/registration/ and follow the instructions 
there. The Program ID of URL Organizer 2 is P2.

You will find instructions on OSoLiS’s site, but the basic steps are:
1. Register your contact details.
2. Buy a license for URL Organizer (Program ID: P2).
3. Download a copy of your Personal License Register (or have it e-mailed to you).
4. Exit from any SIVL-compliant programs (e.g URL Organizer 1) that you are running.
5. Move the License Register to the active Windows directory (usually C:\WINDOWS, but it 

might be C:\WIN95, C:\WIN98 or C:\WINNT). If you’re not sure where to put the License
Register, run URL Organizer and check About URL Organizer under the Application menu.

Can’t replace existing License Register
If you find you get an error when trying to move your Personal License Register to the 
Windows directory, you probably still need to exit from all other SIVL-compliant programs 
that you are running (including URL Organizer 1).

See also:
• Registration Problems



Registration Problems
If you have difficulties obtaining your Personal License Register from OSoLiS, please contact 
them at client.support@osolis.com.

If URL Organizer doesn’t recognize that it is registered, please check About URL Organizer 
under the Application menu to see what is wrong. Below are some suggestions for what to 
do depending on the message you see. If you still don’t have any joy, then please e-mail me
with the message URL Organizer reports.

License Register missing
You must place the Personal License Register in the directory that URL Organizer says it is 
looking in. If the file you have is called licenses.zip, then you must ‘unzip’ it to extract the 
actual Personal License Register. If you don’t know how to unzip a file, or you have lost your
Personal License Register, see below for how to obtain a new copy of your Personal License 
Register.

License Register corrupt
If the Personal License Register has become corrupted, then you will need to obtain another 
copy: see below.

To obtain a new copy of your Personal License Register
1. Log back into your account with OSoLiS using the Register button in About URL 

Organizer, or starting from http://www.osolis.com/en/registration/.
2. Click on the License Register button.
3. Choose to have your Personal License Register e-mailed to you unless you have difficulty 

receiving attachments.
4. Install your Personal License Register in the active Windows directory as before, 

overwriting your existing Personal License Register if applicable.



Upgrades
New releases of URL Organizer fall into two categories: ‘updates’ and ‘new editions’. All 
updates to URL Organizer 2 are free to registered users of and carry a version number 2.x.

The next major release of URL Organizer is likely to be a new edition, though it may be 
preceded by one or more minor updates. The next new edition will be called ‘URL Organizer 
3’; it will carry a version number 3.x; and will require a new license for which a fee may be 
charged. However, registered users of URL Organizer 2 will be entitled to upgrade to URL 
Organizer 3 for no more than a third of the regular purchase price.

You can install an update over an existing installation without affecting your preferences, 
URL list files or registration status.

See also:
• Plans for Future Releases
• Registration Problems



Installing
To install URL Organizer for the first time, run setup (or setup.exe). You will be presented 
with various set-up options, described here. You can change any of these options even after 
URL Organizer has been installed.

Location of application files
Choose the folder in which you want URL Organizer and the help files to be stored.

Shortcuts
• Desktop: Include a shortcut on the desktop
• Quick Launch bar: If you have Internet Explorer 4.0 with ‘Desktop Update’ installed, then 

you can include a shortcut in the Quick Launch bar in the Task bar.
• Startup items: If you want URL Organizer to launch when you start up your computer, 

include a shortcut here.
• Start Menu: Include a shortcut in the Windows Start menu. You can choose the folder in 

which the shortcut should be added.

Default location for list files
This folder is the one you will be offered first when you save a new URL list. It is also where 
the sample URL list file will be moved. You can either use the application folder or you can 
choose another.

Re-installing
You can re-install URL Organizer any number of times without affecting your registration. As
long as you don’t move or erase your Personal License Register then URL Organizer will 
recognize that it is registered.

See also:
• Changing Set-up after Installation
• Registering & Purchasing a License
• Registration Problems



Uninstalling
To uninstall URL Organizer choose Uninstall from the program’s Application menu. You will 
then be asked which components you wish to remove before they are finally erased. (If you 
only want to reset the Windows Registry entries, uncheck the other items.)

You can also use the Windows Add/Remove Programs Control Panel to start the uninstall 
process.



About URL Lists
URL Organizer stores your URLs in a simply-formatted text file. Internet Explorer’s method 
of storing shortcuts is inherently slow and offers no facility for storing notes; Netscape’s 
bookmark file can be difficult to edit manually, and cannot be extended; so I came up with a
simple, readable format to use instead.

URL Organizer supports up to 10 different list files concurrently. This effectively gives you 
another level in the hierarchy above Category. You might have one list for business-related 
URLs, one for leisure URLs, and one for applications installed on your computer, and others 
created for one-off projects. If you’re using URL Organizer at home, you can let family 
members build up their own lists independently.

Each list can hold up to 10,000 URLs. In the unlikely event that you also have more than 
10,000 category and subcategory headings, you will find that the limit is just under 10,000 
URLs. However, you would be much better advised to break your URL collection into smaller 
parts, and save each in a separate URL list (see Moving URLs and Headings).

You can switch between lists on-the-fly from the List menu or using the Ctrl+<digit> 
shortcut indicated in the List menu.

If you use more than one computer, you can access a list file over a network, or you can 
store one copy in a ‘Briefcase’ to keep it synchronized with the master copy.

See also:
• Adding or Removing a URL List
• Saving a URL List
• Importing a URL Collection
• Exporting a URL List
• URL List Backups
• Moving URLs and Headings



Adding or Removing a URL List
To include an existing URL list in the List menu
1. Select Configure from the List menu.
2. Click on the New/Add button.
3. Select the list in the file browser and click Open
4. If necessary, edit the name that URL Organizer uses to refer to the list.
5. Click Done.

To create a new, blank URL list
1. Select Configure from the List menu.
2. Click on the New/Add button.
3. Select the folder in which you want to save the new URL list
4. Type the name you want to give the new URL list and click on Open
5. If necessary, edit the name that URL Organizer uses to refer to the list.
6. Click Done.

To create a new URL list from Netscape bookmarks, Internet Explorer favorites, an Opera 
Hotlist or your Start Menu, see Importing a URL Collection.

To remove a URL list from the List menu
1. Select Configure from the List menu.
2. Click on the Remove button. (This does not erase the list file.)

Drag names up or down the list box to change the order in which they appear on the List 
menu.

See also:
• Importing a URL Collection



Saving a URL List
URL Organizer automatically saves the open URL list whenever you switch viewing mode or 
switch to another URL list (but you are prompted first if you have made changes in Organize
mode. To force changes to be saved at any other time, select Save from the List menu, type
Ctrl+S or, in Organize mode, click on the Save button.

You can save a copy of an open URL list by selecting Save Copy from the List menu and 
choosing a location and name for the copy.

See also:
• Exporting a URL List
• URL List Backups



Importing a URL Collection
URL Organizer can import favorites from Internet Explorer, bookmarks from Netscape 
Navigator, Hotlists from Opera and shortcuts from your Start Menu. Here’s how:
1. Select Configure from the List menu to bring up the URL Lists Preferences.
2. Press the Import button.
3. Click on the type of URL collections you want to import.
4. If desired, change the path name of the new* URL list that will hold your imported URLs.
5. Press the Import button.
6. If there’s a problem, check that the Source file or folder is correct, and if necessary 

choose another.

In order to fit your URLs into a 3-tier hierarchy, URL Organizer has to do some pre-
arranging of its own. These changes are only reflected in the imported URL list, not in your 
original favorites/bookmarks/Hotlist/shortcuts. 

Where you have URLs that are at the top level of the URL collection, URL Organizer inserts 
both a category and subcategory heading (‘Uncategorized’) above those URLs. Where you 
have URLs one folder down from the top level, URL Organizer inserts a subcategory heading
(‘Uncategorized’) above those URLs. You can change the ‘Uncategorized’ headings to 
something else afterwards.

Where you have URLs more than two folders down from the top level, the bottom level 
folder is effectively moved up one or more levels to become a subcategory. Because this 
may not be what you want, it may be advisable before you import to rearrange the folders 
so that you don’t have any folders within folders within folders.

Ideally you would start with a URL collection that has: 
• a top level of just category folders
• a second level of just subcategory folders
• and a third level of just URLs

*Merging with an existing URL list
URL Organizer will only import URL collections into a new list. If you want to add the 
imported URLs to an existing URL list, you can do this simply as follows:
1. Import the existing URL collection to a new URL list file (e.g. ‘Imported URLs’).
2. Mark all of the categories in ‘Imported URLs’.
3. Switch to the list you want to add the imported URLs to.
4. Select Duplicate Marked from the Edit menu.

Note that URL Organizer will not detect duplicate URLs if there are any.

See also:
• Adding or Removing a URL List



Exporting a URL List
URL Organizer can export a URL list as Internet Explorer favorites, Netscape Navigator 
bookmarks or as an Opera Hotlist:
1. Select Configure from the List menu to bring up the Lists Preferences.
2. Press the Export button.
3. Choose the source URL list.
4. Select the export format.
5. Check or choose the path name of the favorites folder or bookmark file to which the URL 

list will be exported.
6. Press the Export button.

Internet Explorer
Each exported shortcut is saved with the following path name relative to the folder you 
select for export: <Category title>\<Subcategory title>\<URL title>.

Beware of overwriting existing favorites if you export your URL list into an existing Internet 
Explorer Favorites folder.

Netscape Navigator
URL Organizer cannot automatically merge exported URLs with an existing Bookmark file. If 
you need to add your URLs to an existing bookmark list, you can do this as follows:
1. Import the existing Bookmark file into a new URL list file (e.g. ‘Netscape Bookmarks’).
2. Mark all of the categories in ‘Netscape Bookmarks’.
3. Switch to the list you want to export.
4. Select Duplicate Marked from the Edit menu. (This adds the imported Netscape 

bookmarks to your URL list.)
5. Export your URL list as a new Netscape Bookmark file.

Note that URL Organizer will not detect duplicate URLs if there are any.

Opera
To merge your URLs with an existing Hotlist, simply export your URLs to a new Hotlist file. 
Then in Opera, right-click on the Hotlist window and select File > Insert File, and select the 
exported Hotlist file.

Note that Opera will not detect duplicate URLs if there are any.

See also:
• Saving a URL List



URL List Backups
URL Organizer automatically creates a backup copy of your URL lists. This happens when 
you or URL Organizer save changes for the first time after loading a URL list. (Be aware that
URL lists are reloaded each time you make a selection off the List menu.) The backup copy 
is saved in the same folder as the original list and is called ‘Autobackup of [name of original 
list file]’. (Note that the name of the URL list file may not be the same as the name of the 
URL list as reported on the List menu in URL Organizer.)

Restoring a backup
If you realize that you’ve accidentally saved changes you didn’t mean to make:
1. Exit URL Organizer.
2. Using Windows Explorer, open the folder where you store your URL list file.
3. Check that there is a backup of your URL list called ‘Autobackup of …’
4. Delete the regular URL list file (not the autobackup copy).
5. Rename the autobackup copy to have the name of the regular URL list file (by deleting 

the words ‘Autobackup of ‘).
6. Reload URL Organizer.

Salvaging a corrupted URL list
If you notice that a URL list has become corrupted (perhaps because of a computer crash) 
then, AS LONG AS YOU HAVEN’T SAVED CHANGES since loading the URL list, you can 
restore the backup copy that was made when you last loaded that URL list:
1. Don’t exit URL Organizer.
2. Using Windows Explorer, open the folder where you keep your URL list.
3. Check that there is a backup of your URL list called ‘Autobackup of …’
4. Make a copy of the autobackup file by selecting, copying and pasting it (see Explorer’s 

Edit menu).
5. Exit URL Organizer.
6. Delete the regular URL list file.
7. Rename the file you created in step (4) to have the name of the regular URL list file (by 

deleting the words ‘Copy of Autobackup of ‘).
8. Reload URL Organizer.

See also:
• Saving a URL List



Manually Editing a URL List
You can edit a URL list using a text editor as long as you bear in mind the following:
• Do not try to edit a list whilst it is open in URL Organizer 2 (you won’t be able to re-save 

it).
• Each category, subcategory and URL must have a line to itself.
• Prefix each category title with <1>
• Prefix each subcategory title with <2>
• Enter each URL as the full URL (including e.g. http://), then a tab*, then the URL title
• Indentations aren’t necessary, though URL Organizer 2 generates indents for ease of 

viewing
• Other information (such as last visited time) is added automatically after the URL title
• Don’t put any URLs between a category (<1>) and a subcategory (<2>)heading

You are advised as a precaution to save a copy of your URL list before you start editing it!

*Note that in version 1 you could use spaces or commas instead of a tab. Because these are
not recognized in version 2, you may find some URLs are shown with their titles appended. 
If this happens, simply cut the title text and paste it into the title box.



Printing a URL List
URL Organizer does not have any built-in facility for printing a URL list. However since URL 
lists are stored in plain text files, you can use other programs to do this. If you open a URL 
list in Notepad or WordPad (both part of a standard Windows installation), or any other text 
editor, you will see that your URLs are listed in a perfectly readable format, which your text 
editor will be able to print out.

If you want to remove the last-visited times (represented as long numbers), notes or log-in 
names, the easiest way to do this is to copy the entire URL list from a text editor and paste 
it into a spreadsheet (e.g. in Microsoft Excel). You can then select and copy just the first 3 
columns, containing the titles and URLs, and then paste these back into your text editor.



Exporting a URL List to the Web
If you want to place a list of your URLs on a web site (so that you can access it away from 
your own computer), the best solution is to export your URL list as a Netscape bookmark 
file. This displays in a Web browser as a well-formatted list of links and even preserves your
notes (but be careful about letting other people see your log-in names and/or passwords).

When you export your URL list, you should probably choose a folder other than Netscape’s, 
unless you want to overwrite the bookmark file that Netscape uses. You may need to make 
a note of where you save the exported bookmark file so that you can find it to upload to 
your Web site.

See:
• Exporting a URL List



Finding and Opening a URL
To select a URL
1. Select the relevant list from the List menu.

2. Select the category. In Compact   mode  , click on:  

3. Select the relevant subcategory. In Compact   mode  , click on: 
4. Select the title of the URL you want

To search for a URL

    To search for a URL, type the text to search for in the search box and press 
Enter/Return or click on the Search button (shown here). Repeat if the first match isn’t the 
one you’re looking for. URL Organizer searches through all the text in the current URL list 
file, including category titles, subcategory title, URL titles, URLs, notes and log-in names.

To open a URL
Select a URL (so that it’s title is highlighted), then either:

• Click on  when it’s highlighted (as shown here), or
• Double-click on the URL’s title, or
• Type Ctrl+O (the title list box must be the focus, not the Search text box), or
• Drag the title onto a browser window (not available in Organize mode). Note that the
Last Visited time may not be updated (see Known Problems).

To open an Internet URL in the frontmost or in a new window
Click on this button to toggle between these states:

    Open Internet URLs in a new window

    Open Internet URLs in the frontmost browser window
To open a URL with the alternate setting without toggling this button, simply hold down the 
Shift key when opening the URL.

To minimize URL Organizer after opening a URL
Hold down the Alt key when opening a URL and URL Organizer will immediately minimize 
itself. Or you can set URL Organizer to automatically minimize after opening a URL (see 
Behavior Options), in which case holding down the Alt key stops URL Organizer minimizing. 
Pressing F8 minimizes URL Organizer immediately.

How URL Organizer opens a URL
If the URL path begins ‘http://’, ‘ftp://’, ‘file://’ etc, then URL Organizer sends the URL 
directly to the selected web browser. Otherwise URL Organizer asks Windows to open the 
file, using whichever program is associated with the file’s extension type (such as ‘txt’, ‘htm’,
‘gif’ etc).

If you open an html file and the URL doesn’t begin with ‘file://’ (e.g. the URL begins ‘C:\…’ 
or ‘\\fileserver\volume\…’) then the Windows setting for the default browser will be used, 
not the browser selected in URL Organizer.

See also:
• Behavior Options



Adding a URL to a List
There are four ways to bring a URL into URL Organizer:

•  Use the Fetch button (available in Regular and Organize modes) or type Ctrl+E 
(available in all modes) to fetch the URL currently open in the frontmost web browser 
window.

• Drag a shortcut onto the URL Organizer window.
• Highlight a URL contained in a body of text, and drag it onto the URL Organizer 
window
• Switch to Organize   mode  ; click on the rightmost  button; and type the new 
URL and title.

Choose which category and subcategory you want to add the URL to or use the  
buttons to create new headings. Then press Enter/Return in the title input box or click on 
the rightmost 

 button when it is highlighted.
If a list box is already sorted into alphabetical order (see Re-ordering URLs and Headings), 
then new items are inserted in alphabetical order too. Otherwise new items are added at the
bottom of the list box (but you can then re-order them as you want).

Note that you can add e-mail addresses, path names to programs, folders and documents 
as well as Internet URLs, e.g.:

E-mail address: mailto:user@domain.com
E-mail address: mailto:Full Name<user@domain.com>
E-mail:* mailto:Full Name<user@domain.com>?cc=Another 

Person<user@domain.com> &bcc=Secret Agent<user@domain.com>
Program: C:\Program Files\URL Organizer\URL Organizer.exe
Program: D:\WebSvr\System\inetsw95.exe -w3svc -msftpsvc
Local folder: C:\My Documents\
Network folder: \\Network Volume\Disk Name\My Documents\
Document: C:\My Documents\To Do List.txt

Make sure that you include the full path name, including extension (‘.doc’, ‘.exe’, ‘.bat’ etc), 
of any programs or documents you reference.

*This probably only works with Outlook    Express.

See also:
• Re-ordering URLs and Headings
• Importing URL Lists



Editing a URL or Heading
Editing a URL or heading is simple:
1. Switch to Organize   mode  .
2. Select the relevant title or heading.
3. Click on the edit box showing the item you want to change (the edit box will change to a 

white background).
4. Edit the text.

See also:
• Moving and Sorting URLs and Headings



Deleting a URL
Deleting a URL is simple:
1. Switch to Organize   mode  
2. Select the URL or heading you want to delete
3. Press the Delete key or click on the  button below the item you want to delete.

If you try to delete a category or subcategory title that isn’t empty, you will be prompted to 
confirm that you want to delete it.



Moving URLs and Headings
To move one or more URLs or subcategories to a different ‘branch’ of the list:
1. Mark the relevant items.
2. Select the category or subcategory under which you now want the marked item(s) to be 

listed.
3. Select Move Marked from the Edit menu.

Alternative ways to Move items:

• Press the  (Move) button
• Click the right mouse button over the Titles list box and select or Move Marked from 
the popup menu.

This Mark and Move process is similar to Cut and Paste, but you won’t find you’ve 
accidentally lost anything by overwriting what you’ve cut. All marked items will remain 
grayed until Moved or Unmarked, or until you leave Organize   mode  .

Moving and copying items between lists
To move or copy URLs between lists, you follow exactly the same procedure: just switch to 
the list you want to move or copy the items to after step 1. At step 3 you have the option 
either to Move or to Duplicate the marked URLs: if you Move them, then when you next 
save the current URL list you will be prompted to confirm that you want to save changes to 
the source URL list.

See also:
• Marking URLs and Headings
• Making Aliases of URLs
• Re-ordering URLs and Headings
• Manually Organizing a URL List



Making Aliases of URLs
URL Organizer permits you to have the same URL mentioned in more than one place in a 
URL list using a system known as ‘aliasing’. When you create an alias, you create a link to 
the URL rather than a duplicate. This means that you can modify a URL’s details (e.g. the 
attached note or the Last Visited time) by modifying any of its instances.

To create an alias of one or more URLs:
1. Mark the URLs you want to create aliases of.
2. Select the subcategory under which you want the aliases to appear.
3. Select Alias Marked from the Edit menu.

URL Organizer manages aliasing entirely transparently: you can re-title or Mark and Move 
any instance of an aliased URL. If you delete an instance of an aliased URL you will be 
prompted whether you want to delete all instances or just the selected instance.

See also:
• Marking URLs and Headings
• Moving URLs and Headings



Marking & Unmarking URLs and Headings
Ways to Mark items
• Hold down the Control (‘Ctrl’) key down while you click on an item you want to mark.*
• Switch to Organize   mode   and select the URL or subcategory you want to move and press 

the  (Mark) button.
• Select the URL or subcategory you want to move and type Ctrl+Shift+X.*
• Select Mark/unmark Item from the Edit menu.**
• To select all the items in a list box together, click the right mouse button over the list
box and select Mark All Here from the popup menu.
• To select consecutive items, click on the first item then Ctrl+Shift-click on the last item.*

* This works in any display mode and automatically switches you to Organize   mode  .
** not available in Compact mode.

Ways to Unmark items

• Select the Marked (grayed) item you want to Unmark and press the  button that shows
in place of the usual 

 button.
• Hold the Control  (‘Ctrl’) key down while you click on a Marked (grayed) item.
• Click the right mouse button over one of the list boxes and select Clear All Marks 
from the popup menu.
• Select Clear All Marks from the Edit menu.
• To unmark all the items in a list box, click the right mouse button over the list box and 

select Unmark All Here from the popup menu.

Marked items are automatically unmarked after you move, duplicate or create aliases of 
them.

See also:
• Moving URLs and Headings
• Making Aliases of URLs



Re-ordering URLs and Headings
To alphabetically sort items a list box:
1. Switch to Organize   mode  
2. Click on the  button under the relevant list box.

Note that if the list box contains a separator, the items above it are sorted independently of 
those below it; the separator itself doesn’t move.

To re-order individual items in a list box:
1. Switch to Organize   mode  
2. Click on an item and, whilst holding the mouse button down, drag the item up or down 

the list box as required.

See also
• Moving URLs and Headings



Inserting a Separator
To insert a separator (a horizontal line) between headings:
1. Switch to Organize   mode  
2. Click the right mouse button on the item you want to insert the separator before.
3. Select Insert Separator from the popup menu.

See also
• Re-ordering URLs and Headings



Adding a Note to a URL
For each URL you can add a note and/or record your site log-in name. Simply select 
Show/Hide Note from the Application menu, or press the function key F5, to bring up the 
URL Note dialog box. The URL Note dialog box shows the note and log-in name for the 
currently-selected URL; both items are always editable.

N.B. You should not store site passwords in URL Organizer since anyone else using your 
computer could easily access them.

To hide the URL Note dialog box, simply select Show/Hide Note from the Application menu, 
or press the function key F5.

Titles of URLs that you’ve annotated are displayed with a small asterisk (*).



Copying a URL
To copy a single URL (to the clipboard):
1. Select the URL.
2. Select Copy Highlighted URL from the Edit menu, and then select the format you want for

the copied URL. Alternatively, click the right mouse button over the highlighted title and 
select either Copy as Text to copy just the URL as plain text or Copy as HTML to copy the
URL and title as an HTML link.

To copy several URLs (to the clipboard):
1. Mark the URLs you want to copy.
2. Select Copy Marked URLs from the Edit menu, and then select the format you want for 

the copied URLs.

Then just Paste the URL(s) where you want them. 

See also:
• Marking URLs and Headings



Resetting Last Visited Time
The Last Visited time is automatically updated whenever you open a URL from with URL 
Organizer. You can reset it to indicate either that you have just opened the URL, or that you 
have never opened the URL:

• Click the right mouse button over the Last Visited time and select either Set to Never or 
Set to Now.



General Tips
• In Compact   mode  , you can see the full address of a selected URL as a ‘tool tip’ by letting 

the cursor hover over the  button. If you use the cursor keys to change the selection, 
the tool tip is updated immediately.

• You can see the exact time and date when you last visited a URL as a ‘tool tip’ by 
letting the cursor hover over the Last Visited time.
• Use the Ctrl+Tab shortcut to switch back and forth between two URL lists.
• Check out the popup/context menus (click the right-hand mouse button) for useful 

functions, some of which are only available there.
• Get to know the keyboard shortcuts.
• When you switch to URL Organizer from another application, you can immediately type 

text in the Search box (not necessarily the case in Organize mode).
• Use URL Organizer to store program, folder and document shortcuts, even DOS 

commands.



Keyboard Shortcuts
F1 Open Help Notes
F2 Switch to Compact mode
F3 Switch to Regular mode
F4 Switch to Organize mode
F5 Show/hide Note dialog box
Alt+F5 Activate Note dialog box
F8 Minimize URL Organizer
Alt+F4 Exit URL Organizer

Ctrl+O Open URL*
Ctrl+F Find next occurrence of search text
Ctrl+E Fetch URL from frontmost web browser window

(This is also available in Compact   mode  )
Ctrl+S Save changes

Ctrl+Shift+XMark URL to be moved (also Ctrl+click with left mouse button)
Ctrl+Shift+VMove URL to selected location

Ctrl+L Configure URL Lists
Ctrl+B Configure Web Browsers
Ctrl+P Configure other Preferences

Tab Advance to next list or text box
Shift+Tab Return to previous list or text box
Return/Enter With caret in the search box: Find next;

With URL title list in focus: Open URL;
With caret in an edit box when an  is highlighted: Add URL/title.

Ctrl+<digit> Switch to a different URL list (see List menu)
Ctrl+Tab Switch to URL list containing marked items or to previously open list

*Modifiers for opening a URL (use with Ctrl+O or when double-clicking on a title):

Shift Open URL with the frontmost/new window choice switched
Alt Open URL then minimize URL Organizer (or, if auto-minimize is set, don’t 

minimize URL Organizer)

Most keyboard shortcuts are indicated on the menus.



Preferences & Configuration
There are three sets of preferences you can modify. When you press Apply, the changes are 
applied immediately (and cannot then be canceled), and the Preferences dialog box remains
open. When you press OK, the changes are applied and the Preferences dialog box closes.

See:
• URL Lists
• Web Browsers
• Behavior Options
• Presentation Options



Web Browsers
To add a Web browser:
1. Select Configure from the Browser menu.
2. Click on the Add button.
3. Find the main browser executable file, and click OK.
4. If necessary, edit the name that URL Organizer uses to refer to the browser, and the DDE 

name*.
5. Click Done.

Use the Remove button to remove a browser from the Browser menu.

Drag names up or down the list box to change the order in which they appear on the 
Browser menu.

URL Organizer supports up to 10 different web browsers. This is particularly useful if you 
need to test web sites with different browsers. You can switch between browsers on-the-fly 
from the Browser menu.

*The DDE name is the name that is used by other applications to ‘talk’ to the Web browser. 
Usually this is obvious: it’s the application’s DOS name minus the ‘.exe’, e.g:
Internet Explorer’s DDE name is iexplore
Netscape Navigator’s DDE name is netscape
Opera’s DDE name is opera

If you need help with configuring URL Organizer to work with another Web browser, please 
e-mail me.



Behavior Options
Keep window at front
You can choose, for each of the window modes, whether URL Organizer stays in front of all 
the other windows, even when you’re not using it. (You can always minimize URL Organizer 
to the Task Bar or to the System Tool Tray.)

Use System Tool Tray
If checked, URL Organizer will create an icon in the ‘tool tray’ area (usually at the right hand
end) of the Windows Task Bar (which usually runs along the bottom of your screen). Clicking
on this icon will bring URL Organizer to the front or, if it is already the active window, it will 
hide the program completely. When URL Organizer is ‘minimized’ or hidden it does not take 
up a slot on your task bar, but you can call it back immediately by clicking on the tool tray 
icon. You may find this particularly convenient if you’re using a small screen.

Start program minimized
If checked, URL Organizer will first start minimized to the Task Bar or System Tool Tray. This
is most useful if you set URL Organizer to load when you start your computer (see Setup)

Auto-dock Note window
If checked, URL Organizer will always try to display the Note window immediately to the 
lower right of the main window; or if there’s not room there, then immediately to the lower 
left of the main window; or if there’s no room there either, then centered over the main 
window. Otherwise the Note window always remains where you place it.

Auto-minimize on opening URL
If checked, URL Organizer will automatically minimize after opening a URL. If you don’t 
check this option, you can achieve the same effect by holding down the Alt key when 
opening a URL; if you do check this option, then holding down the Alt key prevents URL 
Organizer minimizing.

Show message-line help
If checked, URL Organizer will display brief help notes in the message line at the bottom of 
the Regular/Organize mode window. The notes describe the functions of buttons menu 
items. The note shown corresponds to the button the mouse is hovering over or the 
currently highlighted menu item.

Application hot key
Choose a keyboard hot key that you can use to immediately bring URL Organizer to the 
front when using another application. Simply delete the hot key (with Backspace or Delete) 
to disable the facility. Make sure you use a key combination that doesn’t have a function in 
another application, since the hot key will override that function. A suggestion: If you have 
an Alt Gr key (functions as Ctrl + Alt) on your keyboard, combine it with a nearby key (e.g. 
‘/’ or ‘\’) that is rarely used in keyboard shortcuts.

Note that a hot key will not work when URL Organizer is minimized to the System Tool Tray 
(see above).

See also:
• Presentation Options



Presentation Options
Window Colors
To set your own window colors, choose Custom. To change a color, click on the swatch and 
pick a new color using the Windows color picker. Note that the Highlights color is used both 
for recently visited URLs and for the text in certain buttons.

Highlight URLs visited within last … days
Type a figure in the box if you want URL Organizer to highlight URLs that have been visited 
within the last so many days. Leave the box empty if you don’t want URLs to be highlighted.
The highlight color used is either bright red (default) or the custom Highlights color (see 
above).

See also:
• Behavior Options



Changing Set-up after Installation
You can modify any of the set-up options after installation from within URL Organizer: 
choose Modify Setup under the Application menu.

Location of application files
If you specify a new location for URL Organizer, URL Organizer will exit when you press 
Setup Now. You must then re-launch URL Organizer in its new location. Any shortcuts will be
modified to point to URL Organizer in its new location.

Shortcuts
If you deselect a shortcut option, the corresponding shortcut will be deleted; if you select a 
new shortcut option, the corresponding shortcut will be created.

Default location for list files
If you change this, then any URL lists in the current default folder will be moved to the new 
location.

See also 
• Installing



Problems
If you encounter serious problems with URL Organizer, please check first that you are using 
the latest version by visiting the program’s Web site. If URL Organizer doesn’t recognize 
that it is registered, see Registration Problems.

If you are experiencing problems with the latest version, these are two possible causes 
which you may wish to investigate:
The current URL list is corrupt
• Switch to a different URL list, or create a new one: does that work OK?
• Open the URL list in a text editor. Does it look OK?
• If a URL list becomes corrupted, you can replace it with the automatic backup copy.
The Windows Registry settings are corrupt
• Choose Uninstall from the program’s Application menu.
• Select only Remove entries from Windows Registry and press Uninstall Now.
• When you next run URL Organizer it will recreate the entries with default values.

If you can’t solve a problem then please contact me with the following information and I will
endeavor to come up with a solution:
1. The version of URL Organizer you are using (see About URL Organizer)
2. The Operating System you are using (see the System Control Panel).
3. The steps you took before the problem occurred.
4. Whether you can now reproduce the problem following the same steps.

Known problems
The following are problems I am aware of:

Internet Explorer: ‘Frontmost’ window is not actually frontmost
If using Internet Explorer, you may sometimes find that a URL is opened in a window that is 
not actually frontmost, and that Fetch URL retrieves the URL from a window that is not 
actually frontmost. This is a limitation of Internet Explorer. The workaround is to drag the 
URL title onto the window you want the URL to open in.

Internet Explorer: Shift key interacts with opening URL in frontmost window
If you use the Shift key to invert the action of opening a URL to open a URL in the frontmost
Internet Explorer window, you must release the Shift key before Internet Explorer attempts 
to open the URL or it will not open it. This is a peculiarity of Internet Explorer.

Opera: URLs open in Opera when another browser is selected
If you have Opera loaded but you have Internet Explorer or Netscape Navigator selected in 
URL Organizer as the current browser, you may find that URLs will open in Opera’s 
frontmost window, rather than in the selected browser’s. This is a ‘feature’ or bug of Opera, 
which poses as Internet Explorer and Navigator whilst loaded.

Drag and Drop: URLs dragged from URL Organizer do not drop
URL Organizer implements the core features of drag and drop, but these are not all 
implemented by all applications (e.g. Opera and Microsoft Outlook Express). In these cases 
you should use URL Organizer’s alternative methods to open or copy a URL.

Drag and Drop: Last Visited time is not updated
URL Organizer receives very limited feedback about what happens to a dragged URL: it 
doesn’t even find out if the URL was dragged onto a Web browser or a text editor. The way I
have implemented it, URL Organizer updates the Last Visited time if you drag a URL onto 
Internet Explorer, but not if you drag it onto most other applications. Therefore you may 



want to use the Drag and Drop feature to open a URL only in Internet Explorer (which 
allows you to get around the problem of Internet Explorer mistaking the frontmost window -
see above).



Frequently Asked Questions
Most questions I have received in the past are answered elsewhere in these help notes. 
These though are a bit more philosophical:

Why this non-standard interface?
Windows Explorer-style tree lists and hierarchical menus permit you to create any number 
of levels, but they are slow to navigate around, are cumbersome to edit, and they clutter 
the screen. By contrast, URL Organizer’s interface requires you to make no more than three 
mouse clicks to get to a URL; editing, re-ordering or regrouping items is quick and easy; 
and the interface is compact.

Why only three levels?
To create a compact, simple but powerful interface. If you have, on average, 15 items at 
each level, you can comfortably store over 3,500 URLs. If you break your URL collection into
separate lists (effectively creating a fourth level), you can readily store and retrieve tens of 
thousands of URLs. You can use separators to achieve visually what another sub-level 
would. And you won’t find yourself wasting time drilling down 5 levels to find a URL that you
can’t quite remember how you categorized. Sometimes restrictions can be liberating.



Support & Feedback
Support is always available by e-mail if you encounter a problem or can’t work out how to 
do something. But please check the Help notes first to save both you and me time.

The URL Organizer Web site is kept up-to-date with news of the latest version available and 
a link to download it. If you have a comment, gripe or suggestion, feel free to e-mail me. If 
you discover a bug, I can usually get a fix posted to the Web site within a few days. If you 
have requests or suggestions, I can let you know if or when I intend to implement them.

Web site
http://www.osolis.com/hosting/urlorg/ or
http://www.osolis.com/cgi-bin/program.cgi?2

E-mail
urlorg@osolis.com

Thank you for choosing URL Organizer.
Edward Leigh 



History of Changes

1.x Freeware version - now distributed separately

2.0 Released 22 December 1998

2.0.1 Released 02 January 1999
Minor bug fix

2.1 Released 30 January 1999
Enhanced ‘Mark and Move’ to support multiple selections
Added facility to alphabetically sort headings and titles
Added option to highlight recently-visited URLs
Added facility to copy URLs as text or html
Added option to use System Tool Tray
Improved support for application and document shortcuts
Rearranged ‘Organize’ mode screen to include search facility
Many functional and graphical enhancements to interface
Various bug fixes

2.1.1 Released 5 February 1999
Added extra keyboard shortcuts
A few bug fixes

2.2 Released 26 March 1999
Added URL note & site log-in name fields
Added facility to import Opera Hotlists (including URL notes)
Added facility to import Start Menu shortcuts
Improved pre-formatting of imported URL collections
Importing & exporting Netscape bookmarks retains URL notes
Removed limitation on number of items at each level
Increased URL list limit to 10,000 URLs
Items selected in a list now remembered between sessions
Added ‘Mark All’ and ‘Unmark All’ items in a list box
Added keyboard shortcut to minimize URL Organizer after opening a URL
Added hot key facility to bring URL Organizer to the front
Added tool tip showing the exact date and time URL was last visited
Added color preference for marked items
Permit user to set ‘recent’ period for highlighting URLs
Automatically creates backup copies of URL lists
Altered ‘Organize’ mode functionality
Altered keyboard shortcuts: F5 becomes F8; Ctrl+Shift+O behaves differently
Fixed problems with importing Internet Explorer favorites
Minor bug fixes and tweaks to interface

2.2.1 Released 9 April 1999
Added ‘Save Copy’ function
Enhanced drag and drop support
Improved list file handling, particularly for networked list files
Minor tweaks to interface

2.2.2 Released 4 May 1999
Added asterisk indicator for annotated URLs
Location of last-imported Netscape bookmark file now remembered
Minor tweaks to interface



Fixed various bugs, including disappearing notes

2.2.3 Released 17 June 1999
Tweak to ‘Compact’ mode behavior
Various minor bug fixes

2.2.4 Released 13 July 1999
Updated import tools to read Opera v3.6 Hotlists

2.3 Released 1 September 1999
Main windows, list boxes and note box are now all fully-resizable
Added facility to move or copy URLs between lists
Added support for aliases (multiple instances) of URLs within a list
Added support for section separators
Added facility to export as an Opera Hotlist format
Items are inserted into a sorted list box correctly-ordered 
Permits deletion of non-empty categories and subcategories
Added pop-up options to set Last Visited time to now or ‘never’
Added message-line help prompts for menu items
Added option to turn message-line help prompts off
Enhanced copy-to-clipboard options, including copying multiple URLs
Drag and drop now drops html links onto html documents
‘Edit’ menu included in ‘Regular’ and ‘Organize’ modes
‘Display’ preferences split into ‘Presentation’ and ‘Behavior’
Note window auto-docks below main window if no room to right or left
List boxes now permit dragging of item to bottom line
Added option to start minimized
Added option to auto-minimize after opening a URL
Added popup context menu to application and note windows
All functionality now available during 30-day evaluation period
Added index to Help notes
Program registers with ‘Add/Remove Programs’ Windows Control Panel
Esc is no longer a shortcut for Exit
Alt+F5 activates/deactivates the Note window
Various modifications to interface



Plans for Future Releases
Features being considered for inclusion in a future release:
• undo of changes made in Organize mode
• user-selectable fonts
• additional note fields, including passwords (stored encrypted) and star ratings
• fetch URL from any browser window
• automatically maintain in nominated subcategories aliases of ‘recently visited’ and 

‘recently added’ URLs
• advanced search facility that interactively lists all matches
• maintain list of searched-for terms
• print and/or export a (more) printer-friendly URL list
• merge URL lists, favorites or bookmarks with an existing list
• de-duplicate lists
• import favorites from AOL

If you have a suggestion, please feel free to e-mail me.

See also:
• Upgrades



Background & Credits
My motivation for developing this arose from frustration with using hierarchical pop-up 
menus and collapsible ‘tree’ lists to store URLs. My priorities in seeking a solution were (and
still are):
• Quick access to any URL, no matter how many stored
• Simple interface, using a minimum of screen space
• Speedy editing and re-organizing of URLs
• Portability of URL collections and ease of backup
• Concurrent support for multiple browsers for testing web sites
• Low computing requirements (‘efficient’)

URL Organizer incorporates the SIVL verification software under license from OSoLiS 
(http://www.osolis.com/). ‘OSoLiS’, ‘SIVL’ and ‘Personal License Register’ are trademarks of 
OSoLiS LLC.

The development environment I use is Microsoft Visual C++ 5.0.

My thanks go to all those users who have helped test URL Organizer and who have made 
constructive suggestions on how to improve and refine it. In particular the contributions of 
John Gibney and George Davis have been invaluable.



Organize mode is accessible from the Application menu or by pressing the F4 function key. 
You should switch to this mode to add to or reorganize your URLs. You are not committed to
any changes you make in Organize mode until you press Save.



Regular and Compact modes are accessible from the Application menu or by pressing, 
respectively, the F3 or F2 function key. You should use either of these modes when not 
adding to or reorganizing your URLs since there’s no danger that you’ll change or delete 
something unintentionally. The URL list is saved (updating your notes and last visited times)
when you switch mode, switch to another URL list, or exit URL Organizer.



Wherever you need to enter a file path, you can either type it directly into the edit box, or 
you can use the {button ...,} button to bring up a file/folder browser dialog box.



URL Organizer 1 is the freeware parent of this program. It offers a very basic, and relatively
inflexible interface, but if a free lunch is what you’re after, see the home page at 
http://www.osolis.com/cgi-bin/register.cgi?1 for more details.




